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このリリースについて 
本書では、IMAGINE Photogrammetry（旧LPS Core）とERDAS ER Mapperを含め、ERDAS IMAGINE 2016 v16.1の
機能強化について説明します。本書には製品リリース時点での最新の情報が反映されていますが、最新バージョンについては、Hexagon 
Geospatial SupportのWebサイトを参照してください。 
 
このリリースには、機能強化と修正の両方が含まれています。このリリースでERDAS IMAGINEに対して⾏われた修正については、「Issues 
Resolved」を参照してください。 
 
本書では製品の機能の概要だけを示し、詳細をすべて説明しているわけではありません。詳細については、ERDAS IMAGINEのオンライン 
ヘルプとその他の付属ドキュメントを参照してください。 

ERDAS IMAGINEの製品群 
ERDAS IMAGINE®は、⾼度なリモート センシング解析と空間モデリングを実⾏することで新しい情報を作成します。また、ERDAS IMA
GINEでは、2D、3D、動画、地図製作並みの地図構成で結果を表示できます。ERDAS IMAGINE製品群の中⼼部分は、地理空間
データの生成に対するユーザーのニーズに対応できるように設計されています。また、生産性を⾼め、機能を拡張するための専門的な機能を
提供するオプション モジュール（アドオン）も⽤意されています。 
 
IMAGINE Essentials®は、地図作成ツールとシンプルなフィーチャー収集ツールを備えたエントリレベルの画像処理製品です。IMAGINE 
Essentialsでは、シリアル バッチ処理が可能です。 
IMAGINE Advantage®は、⾼度なスペクトル処理、画像登録、モザイク化と画像解析、変化検出などの機能を備えています。IMAGI
NE Advantageでは、パラレル バッチ処理によって出⼒を⾼速化できます。 
 
IMAGINE Professional®には、⾼度なスペクトル処理、ハイパースペクトル処理、レーダー処理、および空間モデリングのための製作ツー
ル セットが⽤意されています。また、ProfessionalのライセンスでERDAS ER Mapperも動作可能です。 

 
新しいプラットフォーム 
ArcGIS 10.4.1 
ERDAS IMAGINE 2016 v16.1は、Geodatabase Supportライブラリを提供するために、ライセンス版のArcGIS 10〜10.4.1がイ
ンストールされた環境でテストされており、この環境を使⽤している場合にサポート対象となることが発表されました。また、IMAGINE Geod
atabase Supportコンポーネント（ArcGIS Engine 10.1ベース）をインストールして、Geodatabaseをサポートすることもできます。 
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Windows 10 
v16.1 Updateのリリースにより、Windows 10でERDAS ER Mapperがサポートされます。 

新しい技術 
IMAGINE SAR Feature 
ERDAS IMAGINEのこのアップデートで対象となった重要な開発分野の1つは、IMAGINE SAR Featureという新しいアドオン モジュー
ルのリリースでした。 
 
IMAGINE SAR Featureは、アナリストがリアルタイム環境でレーダー画像の処理と表示を最適化できるようにする、対話型運⽤ワークス
テーションです。このワークステーションを使⽤すると、エンハンスメントの最適化を可能にするために、⾼度なSARアルゴリズムをすばやく変更
し、表示できます。その後、フル画像を加⼯処理して情報製品にすることができます。提供される機能として、スペックル抑制、画像アニーリン
グ、ターゲット検出、変化検出、フィーチャー抽出などがあります。センサーのレーダー画像を業界標準の情報に変換するために、機能を組み
合わせて処理方法を作成できます。このワークステーションはERDAS IMAGINEに完全に組み込まれており、アドオン モジュールとして販売
されます。 
 
機能は、ERDAS IMAGINEのアイコン パネルの[SAR Feature]タブに表示されます。 
� 運⽤ワークステーション – すべての機能がプロセスフロー駆動型のワークステーションに組み込まれています。すべてのツールとアルゴリズ

ム パラメーターが1か所にまとめられています。 

� ⾼速画像表示 – 元のピクセル値の完全性を維持して、ジオメトリック画像とラジオメトリック画像の調整がその場で適⽤されます。 

� すべてのアルゴリズムが最先端であり、レーダー固有のものです。 

� アルゴリズムは、マルチコアおよびCPUとGPUを組み合わせたコンピューティングを利⽤して、優れた計算効率を実現するように設計され
ています。 

� スマート エンハンスメントの最適化 – 画像エンハンスメントや情報抽出で、時間のかかる試⾏錯誤が不要になりました。アナリストはほ
ぼリアルタイムで処理を最適化できます。 

� 画像の動的調整 – アナリストは画像の処理方法を変更し、結果をすぐに確認できます。 

� 正確な測定 – 画像ラスターはその場でジオコード化されてビューアーに表示されます。測定値はすべて、元のピクセル値、画像メタデー
タ、および正確なレーダー センサー モデルに基づいています。 
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概要 
SAR Featureワークステーションは、ビューアー、データを管理するパネル、スマート コントロール、対話型のプロセスフロー アルゴリズム パラ
メーターが含まれた専⽤のアイコン パネルで構成されます。 
 

 
 
要件 
� IMAGINE SAR Featureは、ERDAS IMAGINE 2016 v16.1インストーラーと共に提供されるERDAS IMAGINEアドオンで

す。この機能を有効にするには、別途ライセンスを購入する必要があります。 

� IMAGINE SAR Featureの⾼度な計算機能を最⼤限に活⽤するには、ERDAS IMAGINE 2016 v16.1をマルチコア対応の
最新のCPUにインストールする必要があります。また、CUDA（Compute Unified Device Architecture）によるGPU処理を可
能にするために、（Nvidiaの）⾼度なビデオ カードが必要となります。このソフトウェアは、適切なGPU環境がなくてもCPUだけで実⾏
できますが、これは推奨されません。 

� ご使⽤のGPUがサポートされているかどうかを確認する場合や、アプリケーションに最適なシステムを選択する場合は、NvidiaのWebサ
イトを参照してください。このページには、入手可能な各種NvidiaカードのCompute Capabilityが示されています。IMAGINE SA
R Featureには、Compute Capability 2.0以降が必要です。CUDA 7.5が使⽤されるので、Nvidiaドライバー v352.39以降
をインストールする必要があります。 

 
 
 

Spatial Modelerの新しい演算子 
Hexagon Geospatialでは、Hexagon Smart M.Appの作成などのイニシアチブに基づいて、Spatial Modelerに新しい演算子を追
加し続けています。このセクションでは、新しい（または変更された）演算子を示し、その機能について簡単に説明します。各演算子の詳細
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については、ERDAS IMAGINE 2016 v16.1のヘルプを参照してください。また、これらの機能の多くを使⽤した空間モデルの例について
は、Hexagon Geospatial Communityの「Spatial Recipes」ページを参照してください。 
 
Compute Affine coefficients 

 
オフセット、回転、およびスケールを使⽤して、2Dアフィン変換の係数を計算します。 
 

 
Create Affine Transform 

 
入⼒アフィン係数、ソースCRS、およびターゲットCRSに基づいてアフィン変換を作成します。  
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Create RSETs 

 
Create RSETs演算子に2つの新しいポートが追加されました。 
 
ForceRecomputeフラグは、既存のRSETに関する演算子の動作を示します。デフォルトでは、FilenameInポートで指定したファイル
に識別可能なピラミッドがすでに含まれている場合にRSETが計算されます。ForceRecomputeをfalseに設定している場合でも、この演
算子は識別されたピラミッドに関するメタデータをフル分解能のデータセットに保持することによって、常にRSETアクセスの最適化を試みます。 
 
SubsamplingMethodポートでは、RSETのサブサンプリングに使⽤するアルゴリズムの名前を指定できます。有効な値は、「Auto」、「S
tandard」、「MaxPixelDecimation」、および「Epho3x3」です。 
 
Define Metadata 

 
ラスター データセットのメタデータを含むオブジェクトを作成または変更します。 
 
メタデータは、（Read Metadataがtrueに設定された）Raster Input演算子を使⽤して、ラスター データセットから読み取ることができ
ます。Metadataオブジェクトには、Define Metadata演算子の入⼒ポートに対応する少数の共通フィールドが含まれます（DatasetRef
erence、Classification、Sensorなど）。これらのフィールドに対応するサポートされている形式のメタデータ値は読み取り時に変換されま
す。ラスターの他のメタデータは、FormatSpecificフィールドに配置されます。これらのメタデータには、Dictionary Item演算子を使⽤して
アクセスできます。 
 
Raster Output演算子を使⽤して書き込む直前に、Define Metadataオブジェクトを使⽤してMetadataオブジェクトを接続することで、
メタデータを新しいラスター データセットに書き込むことができます。可能であれば、ClassificationやSensorなどの最上位フィールドが、ラス
ター ファイル形式のメタデータ スキーマに変換されます。 
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Define Security Info 

 
対応する形式（NITFなど）のラスター画像への書き込みに適したSecurity Infoメタデータ オブジェクトを作成します。これらのセキュリティ
関連のフィールドは、MIL-STD-2500Cのセクション6.1.2.1で指定されたNITF 2.1ファイル ヘッダー定義に従います。これらのフィールドに
は、頭字語が「FS」で始まるフィールドが含まれます（ただし、FSCOPとFSCPYSを除きます）。 
 
Features Information 

 
ジオメトリの数、投影座標系、範囲など、フィーチャーに関する基本情報を提供します。 
 

Get DRA Params 

 
ダイナミック レンジ調整（DRA）は、未加⼯の画像データをセンサーのダイナミック レンジから明確に定義されたメトリックのダイナミック レン
ジにマッピングして⾊調処理を実⾏する際に使⽤する手法です。Get DRA Params演算子を使⽤すると、DRA Stretch演算子で使
⽤する必要な入⼒値を取得できます。 
 
この演算子は、SIPS画像チェーンでDRAストレッチの動的性質に適切に対応するために変更され、拡張されました。 
 
EMinAdjIn、EMaxAdjInの各入⼒では、DRAストレッチ範囲の最小DN値と最⼤DN値を指定します。これらの値を指定した場合、P
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MinIn、PMaxIn、および指定したInteractiveChainのデフォルト値よりも完全に優先されます。出⼒ポートEMinAdjOutとEMax
AdjOutは、EMinAdjIn とEMaxAdjInが指定されているかどうかに関係なく、生成されたストレッチ範囲の最小DN値と最⼤DN値を
含む類似するテーブルを提供します。 
 
Get Pixel Value 

 
1点のラスター ピクセル値を読み取ります。出⼒は、IMAGINE.ScalarオブジェクトのIMAGINE.List（ラスター バンドごとに1つ）です。
特定のバンドの指定したx、y位置がNODATAの場合、そのバンドのリスト項目は、IMAGINE.Scalarではなくnullになります。 
 
MapOrFileを「File」に設定すると、座標入⼒XとYはFile座標として解釈されます。MapOrFileを「Map」に設定すると、座標入⼒XとY
は、Rasterの地図座標参照系でMap座標として解釈されます。 
 
OrthoRectify 

 
この演算子は拡張され、SquarePixelsポートが追加されました。このポートでは、他の入⼒が非正方を提示している場合でも、出⼒データ
に正方ピクセル寸法を適⽤できます。 
 
Raster to Bitmap 

 
Raster to Bitmap演算子にIsGreyscaleという新しい出⼒ポートが追加されました。このポートは、BitmapOutがグレースケールか
どうかを示します（これにより、ビットマップを表示するクライアント アプリケーションは、動作を適宜変更できます）。 
 
Remove Georeferencing 

 
ラスター データセットのジオリファレンスを削除します。 
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Remove Item 

 
Remove Item演算子は、DictionaryまたはListから値を削除します。出⼒は、指定した項目が削除されたDataIn入⼒のコピーで
す。 
 
演算子のコンテキスト メニューの[Add Port]を使⽤してItemの入⼒値を追加することで、複数の項目を削除できます。 
 
Set Thematicity 

 
ラスター ストリームのIsThematicフラグを設定またはクリアします。 
 
このセマティック フラグは、出⼒画像を（デフォルトで）セマティックとアセマティックのどちらとしてマークするかを示すためにRaster Output演
算子で主に使⽤されます。また、このフラグにより、Statistics演算子で実⾏された⼀部の計算が変更されます。 
 
Stack Layers 

 
Stack Layers演算子が変更され、Input1とInput2が必須ポートではなくなりました。これは、Iteratorの出⼒をStack Layersに渡
すときに特に役⽴ちます。Iteratorは、可変数の出⼒（1つのみや出⼒なしなど）を返すことができるためです。以前は、複数の入⼒を渡さ
ないと、Stack Layersは失敗していました。 
 
Warp 

 
Warp演算子が拡張され、UsePyramidsポートが追加されました。デフォルトでは、このポートはTrueに設定されています。これにより、特
に空間モデルをプレビューするときに、処理が⾼速化されます。ただし、アップストリーム データからピラミッドを使⽤すると、特に元のデータのピク
セル サイズを変更した場合に、予期しない結果になることがあります。 
 
たとえば、モデルで0.6mのアセマティック パンクロマチック画像を入⼒し、4x4のスムージング カーネルを使⽤して0.6mのピクセル値をフィルタ
ー処理する⼀方で、（WarpとDefine Processing Areaを使⽤して）モデルの空間分解能を2.4mに変更するとします。Warp演算
子が入⼒画像ファイルに使⽤可能なピラミッドを使⽤できる場合、出⼒ピクセル サイズが入⼒の4分の1になるため、モデルで処理するために
ピラミッド レイヤー2にしかアクセスしなくなります（分解能が4分の1に低下）。その結果、ピラミッド レイヤー2はフィルター処理されますが、
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元の1:1のピクセル（ピラミッド0）はフィルター処理されないので、非常にぼやけた出⼒になります。UsePyramidsポートをFalseに設定す
ると、空間モデルはWarp演算子を介して1:1でデータを引き出さなければならないため、求められている分解能でフィルター処理が適⽤され
ます。 

 

 
Spatial Modeler - 全般 
Subsetダイアログ 
以前のバージョンのERDAS IMAGINEでは、Subsetを実⾏しても、標⾼情報やNoDataマスクなど、入⼒画像に関連付けられているメタ
データは出⼒サブセットに転送されませんでした。このリリースでは、このダイアログでSpatial Modelerが使⽤されるようになったので、メタデー
タのこれらの項目を保持（NoDataの場合は導入）できます。また、出⼒ファイル形式も追加されます。 
 
Smart M.Appへのモデルのアップロード 
独自のSmart M.Appを構築するお客様向けに、空間モデルをM.App StudioにアップロードするオプションがSpatial Model Editorに
含まれるようになりました。これは、Smart M.Appでの空間情報処理のSpatial Recipeとしてのモデルの使⽤を促進することを目的として
います。これにより、お客様はSmart M.App環境で使⽤するためにモデルを転送する前に、ERDAS IMAGINEでモデルの構築、テスト、
検証を効率的に⾏うことができます。 
 
このアップロード ユーティリティを動作させるには、IMAGINE M.App Connectアプリケーション（M.App Exchangeから追加コストなし
で入手可能）に登録する必要があることに注意してください。 

 
ERDAS IMAGINE - 全般 
Web（擬似）メルカトルのサポート 
National Map（およびその他のソース）のデータは、Webメルカトル投影座標系を使⽤して配布されます。この座標系のサポートが追加
されました。 
DeltaCue 
DeltaCue変化検出/監視ユーティリティで、Sentinel-2およびLandsat 8プラットフォームからの画像がサポートされるようになりました。
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動作要件 

ERDAS IMAGINE (ERDAS ER MapperとIMAGINE Photogr

ammetryを含む) 
  

                             
1⼀般的にディスク I/O がデータ処理に⼤きく影響します。⾼速なハードディスクは速度向上に寄与します。読込データ、テンポラリーデータ、出⼒データをそれぞれ 個別のディスクに保存すると、処理速度の向上が⾒込ま

れます。RAID ディスクなども⾼速化の⼀つの方法です。 

CPU 
64-bit: Intel 64 (EM64T), AMD 64 または互換性のあるCPU 

(マルチコア搭載のコンピュータを推奨) 

メモリ (RAM) 16 GB 推奨 (8 GB最小)  

ハードディスク 

� アプリケーション︓4 GB 

� サンプルデータ︓7 GB 

ユーザーデータは利⽤⽤途により必要な容量が異なります。1 

OS 

� Windows® 7 SP1 以上、Professional および Ultimate (64-bit) 

� Windows 8 (Standard), Professional および Enterprise (64-bit) 

� Windows 8.1 (Standard), Professional および Enterprise (64-bit) 

� Windows 10 Pro(64-bit) 

� Windows Server® 2008 R2 SP1 (64-bit) 

� Windows Server 2012 R2 (64-bit) 

注意事項: 

� IMAGINE Photogrammetry, ORIMA およびER MapperはサーバーOSに
は対応していません。 

� Windows 8, 8.1及び10でのステレオ表示サポートは、ステレオ表示に対応して
いるグラフィックカードベンダーによるドライバーの対応状況に依存します。 
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2 Windows 標準の OpenGL ドライバーでなく、グラフィックカードに最適化された OpenGL ドライバーの利⽤を推奨します。 

3 IMAGINE PhotogrammetryとORIMAの過去バージョンで認証されたグラフィックカードは互換性があるかもしれませんが、現在のバージョンで認証しておりません。 

4 IMAGINE PhotogrammetryとORIMAの過去バージョンで認証されたステレオモニターは互換性があるかもしれませんが、現在のバージョンで認証はしておりません。 

� ERDAS ER MapperはWindows 8上でサポートされていません。Windows 
8.1は公式サポートではありませんが、実⾏可能なOSと考えられています。 

 

 

ソフトウェア 

� OpenGL 2.1 以上2 

� Adobe® Reader® 7 以上 

� Internet Explorer® 7 以上、または Firefox® 3 以上 JavaScript 有効 

� Java Runtime 1.7.0.80 (APOLLO ProfessionalにWeb Process Ser
vice(WPS)をパブリッシュする場合に必要で、オプション・インストール。IMAGINE 
ObjectiveはJREを必要とするが、インストール及び設定された1.7.0.80以上のJ
REを利⽤できる) 

� Python 3.4 (PythonをSpatial Modeler内で使⽤する場合、オプション・イン
ストール。32-bitはSpatial Model Editorに対して必要とされる。64-bitはバッ
クグラウンド処理で必要とされる) 

� Microsoft DirectX® 9c 以上 

� .NET Framework 4.0 

� MSXML 6.0 

推奨グラフィックカード 
� NVIDIA® Quadro® K5200, K4200, K2200, K4203  

� NVIDIA Quadro K5000, K4000, K6003   

ステレオ実体視⽤ 

推奨ディスプレイ 
� NVIDIA 3D Vision™ Kit4 に対応した 120 Hz LCD モニター4 
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5 HP-RTL ドライバーを推奨します。64-bit 版の Windows プリントサーバーには、64-bit のプリンタドライバーが必要です。  

6 Stereo Analyst for IMAGINE は Stealth S-Mouse (S2-S モデル) および、Mouse-trak に対応しています。Z/I Mouse および TopoMouse は対応していません。 

7 IMAGINE Photogrammetry 2016では、3Dconnecxion SpaceExplorer Mouse に対応しています。 

周辺機器 

ソフトウェアインストールを⾏うため次の機器が必須:  

� Microsoft Windows 互換マウス（スクロールホイール付き） 

� Microsoft Windowsをサポートするプリンタ5  

ライセンス管理上(Intergraph Licensing 11.13 .2)、次のうちの１つが必須︓  

� イーサネットカード、または 

� ハードウェアキー⽤USB ポートx1 

 

より⾼度な⽤途には以下のハンドコントローラを推奨6:  

� TopoMouse™ または TopoMouse USB™  

� Immersion 3D Mouse  

� MOUSE-TRAK  

� Stealth 3D (Immersion), S3D-E タイプ, シリアルポート 

� Stealth Z, S2-Z モデル, USB 対応  

� Stealth V, S3-V タイプ (シリアルデバイス)  

� 3Dconnexion SpaceExplorer mouse7  

� EK2000 Hand Wheels  

� EMSEN Hand Wheels  

� Z/I Mouse 

GeoMedia, ArcGIS及び

データベースとの互換性 

� ERDAS IMAGINE は、GeoMedia 2016がインストールされた コンピュータに
安全にインストールすることができます。この時、GeoMediaを先にインストールする
必要があります。 
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� ERDAS IMAGINE 2016とGeoMedia 2016のビューアーのリンク機能を使⽤
するには、GeoMedia のバージョン2016が必要です。 

� ERDAS IMAGINE 2016 は、Esriのパーソナルジオデータベース(.mdb)とファイ
ルジオデータベース(.gdb) 形式のベクターデータを取り扱えます。 

� ERDAS IMAGINE 2016は ArcGIS® versions 10から10.4.1までのコンピ
ューターにインストールすることができます。 

� ERDAS IMAGINE およびIMAGINE Photogrammetry 2016 は共にArc
GIS Server 10の Geodatabase servers (ArcSDE)のベクターデータを取
り扱えます。 

Geodatabase データの読み込みや取り扱いを⾏うためには以下が必要です︓ 

� ArcGIS for Server バージョン 10 から10.4.1のインストールおよびライセンス
が使⽤できる環境、または 

� IMAGINE Geodatabase Support のインストール(ArcEngine 10.1に基づ
く。ArcGIS のライセンスは不要) 

� Oracle Server 12c を使って以下のラスターデーターの保存/読み取りが可能で
す。 

o Oracle GeoRaster (.ogr) (requires Oracle Spatial) 

o SDE Raster (.sdi) (requires ArcGIS for Server) 

� Oracle Server 12c を使って以下のベクター/フィーチャーデータの保存/読み取
りが可能です。 

o Oracle features (.ofp) 

o Oracle Spatial Features (.ogv) (requires Oracle Spati
al)   

� Microsoft SQL Server 2014 を使って以下のベクター/フィーチャーデータの保
存/読み取りが可能です。 

o SQL Server Features (.sfp) 
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PRO600  

                             
11

⼀般的にディスク I/O がデータ処理に⼤きく影響します。⾼速なハードディスクは速度向上に寄与します。読込データ、テンポラリーデータ、出⼒データをそれぞれ 個別のディスクに保存すると、処理速度の向上が⾒込

まれます。RAID ディスクなども⾼速化の⼀つの方法です 

12 リストに記載されているその他の要件は、暗黙的にPRO600に適⽤されます。 

13 PRO600の過去バージョンで認証されたグラフィックカードは互換性があるかもしれませんが、現在のバージョンで認証しておりません。 

CPU 
64-bit: Intel 64 (EM64T), AMD 64 または互換性のあるCPU 

(マルチコア搭載のコンピュータを推奨) 

メモリ (RAM) 8 GB 推奨 (4 GB最小)  

ハードディスク 
� アプリケーション︓1 GB 

ユーザーデータは利⽤⽤途により必要な容量が異なります。11 

OS 
� Windows® 7 SP1 以上、Professional および Ultimate (64-bit) 

� Windows 8 (Standard), Professional および Enterprise (64-bit) 

ソフトウェア 

� IMAGINE Photogrammetry 201612 

� 以下のいずれかのBentley Systems製品のうちひとつが必要です。12 

o MicroStation V8i (SS1- SS3 Update 1) 

o Bentley Map V8i (SS1 - SS3 standalone or for Micro
Station) 

o Bentley Map Enterprise V8i (SS1 - SS3) 

推奨グラフィックカード 
� NVIDIA® Quadro® K5200, K4200, K2200, K42013 

� NVIDIA Quadro K5000, K4000, K60013   

ステレオ実体視⽤ 

推奨ディスプレイ 
� NVIDIA 3D Vision™ Kit に対応した 120 Hz LCD モニター14 
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14

PRO600の過去バージョンで認証されたステレオモニターは互換性があるかもしれませんが、現在のバージョンで認証はしておりません。HP-RTL ドライバーを推奨します。64-bit 版の Windows プリントサーバーに

は、64-bit のプリンタドライバーが必要です。 

15
HP-RTL ドライバーを推奨します。64-bit 版の Windows プリントサーバーには、64-bit のプリンタドライバーが必要です。 

16
Stereo Analyst for IMAGINE は Stealth S-Mouse (S2-S モデル) および、Mouse-trak に対応しています。Z/I Mouse および TopoMouse は対応していません。 

 

 

周辺機器 

ソフトウェアインストールを⾏うため次の機器が必須:  

� Microsoft Windows 互換マウス（スクロールホイール付き） 

� Microsoft Windowsをサポートするプリンタ15  

ライセンス管理上(Intergraph Licensing 11.13 .2)、次のうちの１つが必須︓  

� イーサネットカード、または 

� ハードウェアキー⽤USB ポートx1 

 

より⾼度な⽤途には以下のハンドコントローラを推奨14:  

� TopoMouse™ または TopoMouse USB™  

� Immersion 3D Mouse  

� MOUSE-TRAK  

� Stealth 3D (Immersion), S3D-E タイプ, シリアルポート 

� Stealth Z, S2-Z モデル, USB 対応  

� Stealth V, S3-V タイプ (シリアルデバイス)  

� 3Dconnexion SpaceExplorer mouse  

� EK2000 Hand Wheels  

� EMSEN Hand Wheels  

� Z/I Mouse 
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ISSUES RESOLVED 

IMAGINE ESSENTIALS 

CR #  Summary – IMAGINE Essentia

ls  

Description / How to Reproduce  

1-LWV52P  Gokturk MS images are shifted and s

caled incorrectly when displayed in t

he 2D viewer  

The symptom is that the Pan data is displayed correctly, but the 

MS data is scaled incorrectly and also shifted.  

1-BC025L  “Number of simultaneous commands” 

in the IMAGINE Preference will not t

ake over correctly  

Customer reported that the “Number of simultaneous command

s” as set by IMAGINE Preference, will not be taken into accoun

t, when starting a batch job using the submit option. Once you 

click the Submit button, in the Submit dialog, the number of “Si

multaneous process” shows 1, even if you have set more than t

he value 1 in the simultaneous commands setting in Preference 

for Batch. To recreate the problem, please do the following:  

1. Go to IMAGINE Preference > Application> Batch Processing > 

Set the “Number of simultaneous commands” as more than 1, a

s for example 6 > Save.  

2. Launch IMAGINE TIFF importer  

3. After loading one input file and naming output file, Click OK  

4. In the Import TIFF window, click the “Batch” button.  

5. Change your variable and add more files  

6. Then click “Submit button”, you will see that The number of 

“Simultaneous Process” shows as 1, which should, as per Prefer

ence setting be, 6. But that has not been taken over correctly.  

 

When you manually change the number of processes to a highe

r number, in the batch process, it correctly runs with the numb

er entered in the Submit window.  
1-BJ4AO6  ERDAS IMAGINE not persisting meta

data correctly when importing ASTER 

data  

Customer reported that ERDAS IMAGINE is not persisting metad

ata correctly when importing ASTER data. According to the cust

omer, the ASTER importer has this problem from ERDAS IMAGI

NE 2014 v14.1 onward. It extracts the band 3n and 3b images 

and create a blockfile using those two data, but IMAGINE Photo

grammetry gives error message: “Failed to get metadata for” th

e added image.  
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1-H8JX9N  NITF 2.1 export with embedded JPE

G2000 compression can not handle 

NoData value in the input image.  

 

Customer reported that if NoData is defined in the raster file, Ex

port to NITF with JPEG200 compression option gets disabled. Th

e customer is using GeoTIFF data from Pleiades images. The pr

oblem has been recreated with Pleiades as well as with other TI

FF and IMG data. However if the NoData value is removed from 

the input file, the JPEG2000 compression option in the NITF exp

ort dialog doesn’t get disabled. To recreate the problem please 

do the following:  

1. Open the IMAGINE Exporter > Select the export format as NI

TF 2.1 from Imagery , and add your input data > OK  

2. You will see an alert about the image mask. If you continue 

without dropping the mask size, you will see that the “change c

ompression“ option gets disabled. But if you lower the number 

of masks you can see that Change compression option remains 

active.  

3. However if I remove the NoData Value from the Input image 

and do the NITF export the Change compression option remains 

enabled  
1-JM6H0T  ERDAS IMAGINE does not read proje

ction information on JP2 imagery fro

m the National Map  

Open a National Map JP2 image in ERDAS IMAGINE (2015 or 20

16) and note that no projection information is recognised. Open 

it in another GIS package and it is reported as being in Web Me

rcator Auxilliary Sphere.  

1-L1U03E  Help for Landsat 8 importer has inco

rrect specification of which MSI band

s are imported  

This is particularly important to fix because the table in the Help 

is the *only* indication to the user as to what wavelengths the 

imported bands represent and is therefore currently highly misle

ading. Go to the Manage Data tab and click Import Data. Select 

the "Landsat 7 or Landsat 8 from USGS " option, select a vali

d .tar.gz input, specify an output and click OK. In the tertiary di

alog which comes up click Help. The resulting Help file includes 

a table which states that a Multispectral composite will consist o

f bands :1, 2, 3, 4, 5, 7, 9 This is incorrect. Band 6 is missing 

from the list, and band 9 (the Cirrus cloud band) should not be 

included. The actual Multispectral bands for Landsat 8 are: 1, 2, 

3, 4, 5, 6, 7  

1-LRPIQJ  Sentinel-2 dll not selecting correct b

ands for sub-images  

The 10m bands in a Sentinel-2 image are supposed to be 02, 0

3, 04 and 08 (equating to the usual B, G, R, NIR wavelengths). 

However if you open a Sentinel-2 image using the "Only10Meter

Bnads" sub-image option it does not appear to load the correct 
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bands - the fourth band of the image (which is supposed to be 

Band 08) does not appear to be Band 08. It might be Band 05, 

but it certainly isn’t Band 08. You can test this by starting two 

2D Views and loading one with the Sentinel-2 image loaded usin

g defaults (which will load all 13 bands at 10m resolution) and 

the second using the Sub-Image tab and the "Only10MeterBands

" option selected. On the Multipsectral tab, use the band pull-do

wns to manual set the RGB display to 08, 04, 03 and note that 

the displays are different  

1-LRRTXR  ERDAS IMAGINE displays artefacts in 

Sentinel-2 imported images.  

Customer reported that ERDAS IMAGINE 2016 displays artefacts 

in Sentinel-2 when imported. According to the customer if they i

nstead use the RGB importer in ESA’s SNAP v3.0, those artefact

s are not found.  

The ERDAS IMAGINE 2016 software is working as designed - w

hen opening a Sentinel-2 image which covers more than one UT

M zone the granules must be reprojected to a common projecte

d coordinate system. So if the image covers both Zone 31 and 

Zone 32, all the zone 31 granules might be reprojected to Zone 

32. This reprojection is performed using Nearest Neighbor resam

pling and so the standard NN resampling "artefacts" are observe

d in those granules that have had to be reprojected. Such effect

s become more frequent the further away from the base Zone y

ou proceed.  

For v16.1 we will alter the default behavior from NN resampling 

to Cubic Convolution (IM- 34140). The SAFE dataset will still be 

opened as a single image, but the visual appearance of the resa

mpling applied to granules that must be reprojected will be mini

mised by the use of CC resampling.  

For ERDAS IMAGINE 2017 an enhancement request has been su

bmitted requesting that the dataset be openable as Zone-specific 

sub-images so that resampling can be avoided (but at the cost 

of only accessing a zone-specific section of the image at a time, 

as is provided by SNAP).  
1-QLCKZK  ERDAS IMAGINE 2016 crashes while 

opening Sentinel-2 Level 2A atmosph

eric corrected data  

Customer reported that IMAGINE 2016.0 crashes while opening 

Sentinel-2 Level 2A atmospheric corrected data in *.SAFE forma

t.  

1-BM7ATC  Python API (help)- Please add a link 

to Operator Limitation in Workflow.  

Description from customer: In the "Python Scripting in Spatial M

odeler Workflows" it states under the heading Operator Limitatio
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ns "The syntax for a given operator is documented in the Spatia

l Model Editor online-help" but there is no link from here  

1-KX0K1N  Unable to connect to Google Earth P

ro.  

When Google Earth Pro is installed users are unable to connect 

to it from ERDAS IMAGINE.  

In ERDAS IMAGINE 2016 v16.1 the Google Earth tab has been r

e-enabled to be visible and to interact with Google Earth.  

The Google Earth connection will also work with Google Earth Pr

o, but the necessary API is only installed with Google Earth, so 

you must install it as well.  

Also note that Google has ceased support for the API used for t

his feature. Therefore, the Google Earth connection may cease t

o operate with future releases of Google Earth / Google Earth Pr

o.  
1-LC793Y  Problem building pyramids and statis

tics  

Customer reported that ERDAS IMAGINE crashed while performi

ng ISOCLASS classification with 368 band hyperspectral data. Th

e following error occurs while creating the statistics and pyrami

d: Error: “Warning in ethr_ThreadCreate: Thread creation failed: 

Not enough storage is available to process this command”.  

1-M7JGP8  “Correct the Alert problem” - remain

s even after recreating pyramids usin

g "Edit Image Metadata”  

After computing pyramids using the "Edit Image Metadata" dialo

g, when you load the images again they sometimes still come u

p with “Correct the Alert problem” in the table contents and it s

till reads that pyramids need to be updated...and one has to ru

n it again.  

1-QK5K4B  With region set as Netherlands, Crea

te Map Composition operator fails w

hen the OS region is set to Netherla

nds.  

Create Map Composition operator fails to generate an output wh

en the Operating System region is set to Netherlands. The same 

work flow executed successfully with an English OS.  

1-QK5K6B  Create Geospatial PDF operator fails 

when the OS region is set to Netherl

ands.  

Create Geospatial operator fails to generate an output when the 

Operating System region is set to Netherlands. The same work f

low executed successfully with an English OS.  

1-LBFZUT  Some projections missing in finland 

plb file  

Enhancement request to add the following EPSG projections fro

m epsg.plb to finland.plb: EPSG:3067 , EPSG:5048, EPSG:2583

4, EPSG:3046, EPSG:25835, EPSG:3047, EPSG:25836, EPSG:304

8, EPSG:3045, EPSG:3049  

1-LD8QW4  Incorrect name for EPSG:3067  In ERDAS IMAGINE 2016, the EPSG:3067 entries are shown as: 

"ETRS89 / ETRS-TM35FIN (3067)"  

However according to EPSG Registry (epsg-registry.org), the offi
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cial name is: “ETRS89 / ETRS-TM35FIN(E,N)”  
1-RCVW1M  EPSG code 25832 and 4647 are mix

ed up  

When exporting an *.img formatted image to a TIFF format, its 

EPSG code is incorrectly changed from 25832 to 4647. This cau

ses wrong positioning of the exported image  

1-ROZSSD  Incorrect parameters for EPSG:5650  The parameters of EPSG 5650 in epsg.plb is different from the 

official definition of EPSG:5650 in the EPSG registry.  

1-FN8U7B  Drag and dropping files within a Sho

eBox duplicates the file instead of ju

st moving it.  

 

When you drag and drop a file within a Shoebox the file is dupli

cated instead of simply being moved. There is no need to have 

two entries of the same file in the ShoeBox. It used to work cor

rectly in ERDAS IMAGINE 2014.  

1-QKIBSI  ERDAS IMAGINE 2016 is unable to o

pen standard v1.1.1 WMS  

Customer reported that ERDAS IMAGINE 2016 is unable to open 

standard v1.1.1 WMS. Same services open successfully in other 

GIS applications/  

 
 
 

IMAGINE Photogrammetry 

CR #  Summary – IMAGINE Essentia

ls  

Description / How to Reproduce  

1-DSTPZJ  
 

XPro SGM, exclusion polygon  XPro SGM online help mentions that exclusion polygon is suppor

ted but this option is not available in the SGM dialog.  

1-OT8X2F  RPC generation tool doesn't generate 

accurate RPC00B format RPCs from 

WV OR2A block file.  

Exporting to ISAT project is not possible if the block file is set i

n Rational Functions geometric model. I have tested the workar

ound "Using the RPC generation tool, you can generate adjusted 

RPC's from the block file in RPC00B format. You can then create 

an IKONOS ImageStation project with the exported RPC files." I

n order to test the accuracy of the generated RPCs I have creat

ed a block file in IKONOS RPC model and added imagery and R

PC00B format RPCs. There is huge shift in IKONOS RPC block th

at I created after RPC generation. In my triangulated WV RPC b

lock GCPs were right on spot. The data is on: \\alpha\Siebel_B

ug_Data\1-OT8X2F  

1-LC9W5H  Point Cloud Classify tool is not writin

g the projection of the input las data 

to the output file.  

Classify tool in Point Cloud is not writing projection information i

n the output file if the projection is stored in aux file, not from 

the input las file.  

1-M0O60Y  Point Cloud to Raster operator is not Point Cloud to Raster operator is not creating RGB raster output 
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creating correct RGB raster  from Point cloud RGB encoded input data. The output image sh

ows Intensity, Green and Blue.  

1-LWVDOP  Error messages when displaying LAS 

1.4 data in 2D viewer  

Some Point cloud data in LAS 1.4 format are not displayed prop

erly in IMAGINE 2D viewer. You will get several error messages 

when trying to load the data.  

 
 

IMAGINE Professional 
CR #  Summary – IMAGINE Essentia

ls  

Description / How to Reproduce  

1-KYQVLT  

 

Signature Editor crashes when mergi

ng signatures with negative values  

 

Signature Editor crashes when merging signatures that contain n

egative values in their statistics.  

1-B9XSYL  Incorrect error creating sub-model.  In the Spatial Model Editor selecting seemingly continuous group

s of Operators and trying to create a sub-model from the selecti

on can result in an error message: "Cannot create subprocess fr

om this selection. Must select a continuous piece of the model."  

1-BC4AGD  Renamed Commandline operator set 

back to default commandline name a

fter editing anything in the operator  

Customer reported that a renamed Commandline operator is set 

back to its default commandline name after editing anything in t

he operator. This is a problem for user having multiple Comman

dLine operators in the same model. When they edit anything in 

the renamed commandline operator, the operator immediately c

hanges it’s name to the default name, even though you had ren

amed it before starting to edit. Then Spatial Modeler complains 

that there are several with same commandline name.  

1-KZ8EKT  Summary operator causes instability 

(and crash) of ERDAS IMAGINE  

Using a specific Zonal Summary model which basically takes a s

hapefile as raster as the Zones, a floating point image as the Cl

ass Raster and feeds them into Summary. Run the model once 

and it completes. Change the multiplier (from 10000 to 1), or s

ome other parameter of the model, and run again and ERDAS I

MAGINE crashes. Sometimes it even crashes the first time you r

un.  

1-L51HZL  Typing @ and hitting Enter in Operat

or properties crashes ERDAS IMAGIN

E  

Start a Spatial Model Editor. Drag the Eq operator onto the can

vas. Select the Operator. In Properties, place cursor in the Valu

e field of Input2 and type @ and then hit Enter. ERDAS IMAGIN

E crashes. This was encountered because of trying to type "2D", 
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but had the Shift key held down when typing the 2.  

1-LSDYMN  Large (multi-GB) ECW files will no lo

nger Preview in NDVI  

Display large (multi-GB) ColorIR ECW in 2D View.  

On the Raster tab select NDVI.  

On the NDVI GUI click Preview.  

Note that the results never display.  

1-LWW5C9  Create RSETs crashes ERDAS IMAGI

NE if image has previously been ope

ned  

Display (specific) TIFF in a 2D View.  

Clear the View.  

Start Spatial Model Editor.  

Add a Create RSETs operator.  

Define the TIFF as the input file.  

Click Run.  

ERDAS IMAGINE crashes.  

1-M0H0QW  

 

OLH for Attach Vertical CRS is out of 

date  

 

The OLH for Attach Vertical CRS does not match the released v

ersion of the operator. It has the wrong port names and refers 

to rasters only.  

1-M0HN27  Spatial Model ran in Beta, but fails t

o run in Release  

A specific model no longer runs in ERDAS IMAGINE 2016, but di

d apparently run in the Beta build 5306. When Run, it runs for 

about 50 minutes and then crashes ERDAS IMAGINE  

1-M0O5O2  “Point Cloud to Raster” operator is cr

eating partial output raster image  

 

Point Cloud to Raster operator generates partial output raster im

age. For instance, the output raster may be created only for the 

left half of the point cloud data extent.  

1-M19F6D  Define Processing Area changing pixe

l size of ortho image  

Running an ortho raster through Define Processing Area, with all 

of the options (including Cell Size) set to "same as input 1", cre

ates a raster with a slightly different pixel size. The specific mod

el tested has two paths RasterIn->RasterOut and RasterIn- >De

fineProcessingArea->RasterOut. The grid, cell size, window and 

CRS options of the DPA operator are all set to the single, input 

raster. The input image is an ortho in Geographic (Lat/Lon) with 

a cell size with many, many decimal places. The output of the 

RasterIn->RasterOutput path is a raster with _exactly_ the sam

e Map Info as the input. The output of the RasterIn->DefinePro

cessingArea->RasterOut path is a raster with _almost_ the same 

Map Info as the input, but the pixel size is _slightly_ different 

(4.9526297953637308e- 006 vs 4.9526297953630142e-006).  
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IMAGINE Advantage 

CR #  Summary – IMAGINE Essentia

ls  

Description / How to Reproduce  

1-LX0KBG  CSM Plugin Manager will not register 

CSM.dll  

CSM.dll cannot be added in the CSM plugin. The CSM is for a s

pecific sensor. To replicate:  

File > Configuration > CSM Plugin Manager - Use CSM Plugin lib

rary selector to select CSM.dll.  

At this point the Runtime Library menu is updated to Visual Stu

dio 2008 but no model is added to the Available Models section.  

1-LW6IFI  MosaicPro produces line gap between 

abutting edges of tiles with the sam

e projection  

A single line gap is seen when mosaicking tiles that have abutti

ng edges and are registered to an identical projection. The view

er mosaics the tile together as expected.  

 

IMAGINE AutoDTM 

CR #  Summary – IMAGINE Essentia

ls  

Description / How to Reproduce  

1-LR240I  Tridicon SGM crashes when generati

ng pyramid layers  

For aerial frame projects, if images do not have pyramids in the 

format needed by Tridicon SGM, the process generates those py

ramid layers. In ERDAS IMAGINE 2016, SGM crashes during the 

pyramid generation process.  

 

IMAGINE Stereo Analyst 

CR #  Summary – IMAGINE Essentia

ls  

Description / How to Reproduce  

1-KZ8UR1  Y Parallax at the oriented A3 imager

y in Stereo Analyst  

There is a large y-parallax in Stereo Analyst for IMAGINE that is 

not seen in Terrain Editor. Zooming in to a better ratio than 1:1 

or setting epipolar update mode to motion doesn't remove the y

-parallax.  

1-MEG1CN  Opening Space Imaging IKONOS Ster

eo Pair in Stereo Analyst for IMAGIN

E  

crashes  

Steps to reproduce:  

1. Launch ERDAS IMAGINE, Stereo Analyst from Toolbox tab > 

Stereo Analyst.  

2. Launch File > Open > Space Imaging IKONOS Stereo Pair  

3. Select the file *_metadata.txt file  

4. Stereo Analyst for IMAGINE hangs and crashes  
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IMAGINE PRO600 

CR #  Summary – IMAGINE Essentia

ls  

Description / How to Reproduce  

1-JSPK9S  Cursor hangs in MicroStation windo

w.  

When working with ADS data, the cursor in MicroStation window 

does not follow the cursor in the viewplex window. As you roam 

in the viewplex window, the cursor in the MSTN window hangs 

and catches up when the cursor in the viewplex window stops 

moving.  
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変更履歴・利⽤管理 
 

変更履歴 
Ver. 内容 日付 
1.0 初版作成 2016/11/30 
1.1 住所更新 2017/04/05 
   
   

 

   

Hexagon Geospatial製品、およびそのサービスに関するお問い合わせは、 

以下へご連絡ください。 

 
 
 
 
 
 
 
 
 
� 本書に記載された内容は、将来予告なしに変更することがあります 

� 本書の内容の⼀部、または全部を無断で転載あるいは、複製することを禁止します。 

 
 

日本インターグラフ株式会社 

HexagonGeospatial 

〒180-0073 東京都港区三田1-4-28 三田国際ビル18階 

TEL: 03-6809-4051  FAX: 03-6809-4091 

E-Mail:      jp-sales@hexagongeospatial.com 

Webサイト:  http://www.hexagongeospatial.jp 


